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Safety Notice and Symbols
Please take the time to read this manual thoroughly in order to obtain comprehensive knowledge about
this machine before serving it.

General Notice for Serving

1. Before trying to disassemble this machine, make sure the power supply cord of the machine is
disconnected from the power outlet. Under NO circumstance should you remove or install PCBs or
connectors in or on the machine with the power switch turned ON.

2. Use caution not to drop small parts or screws inside the machine when disassembling and
reassembling. If left inside, they might cause a malfunction of the machine.

3. Do not pull the connector cable when disconnecting it. Grasp and pull on the connector only.

4. When carrying PCBs or the scanning head unit, put them in an anti-static bag.

5. Always keep the document glass surface clean. (If contaminated, use a clean wet cloth for cleaning.)

6. Use caution not to injure your fingers or hands when disassembling or reassembling the machine.

Symbols

Symbols Used in this Manual

This manual uses the following symbols:

Symbol What it means

* Refer to section number

s Screw

e E-ring
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Features

Digital Copying

Since the product includes a laser printer, it is able to produce digital copies with outstanding copy quality.
The intuitive control panel and quality LCD-display make digital copying fast and easy.

E-mailing

Connected to an Ethernet network and an SMTP server, this machine allows you to transmit document(s)
to your e-mail as attachment. With a touch of the e-mail key and the selection of your recipients' e-mail
addresses, the document(s) is/are first scanned and converted into an image file, and then transmitted to
remote recipients within minutes.

Filing (Scan to Folder)

This feature allows you to send scanned documents to a server or file folder in a personal computer over
the Intranet via FTP (File Transfer Protocol), HTTP (Hypertext Transfer Protocol), HTTPS (Hypertext Transfer
Protocol Secure), and CIFS (Common Internet File System). The scan-to-folder feature saves the mail server
from handling large attachments.

Faxing

With the built-in fax modem and an additional telephone line, this machine is able to transmit your scanned
document to a remote fax machine just like regular fax machine.

Sending Multi-Page Document

With the Auto Document Feeder, the product enables sending of a stack of 50 pages of documents, which
are consecutively scanned at one time with reliable quality - increasing your work efficiency.

Managing the Machine Remotely

This machine provides a convenient way to manage your e-mail address book, filing destinations (folders),
and telephone book remotely. By simply typing the machine's IP address in the URL field of your browser,
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the machine web page will be prompted. This webpage allows the administrator to create up to 2,000 e-
mail addresses, 40 filing destinations, and 200 fax numbers to conveniently deliver the scanned documents
to multiple recipients.
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1. Installation

Installation Requirements
For details, refer to the Quick Installation Guide for this machine.
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1. Installation
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2. Preventive Maintenance

Preventive Maintenance Schedule

User Maintenance

Clean these parts at every EM.

Abbreviations: C: Clean, R: Replace, EM: Emergency Maintenance

Item 30 K EM Remarks

Exposure Glass - C Wipe with a damp cloth (alcohol or water).

LCD Display - C Wipe with a damp cloth (alcohol or water).

ADF Rollers - C Wipe with a damp cloth (alcohol or water).

Separation pad R C Wipe with a damp cloth (alcohol or water).

The separation pad is supplied as “Scanner Maintenance Kit for Image Scanner IS800C” (G426-18).

For details, refer to the IS800C User’s Manual.

Service Maintenance

Lubricate these parts at every EM.

9
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Abbreviations: L: Lubricant

Item EM Remarks

Sliding rod (*1) L
Launa oil 40

Coat thinly uniformly

Sliding frame (*1) L
Grease-Barrierta S552R

Coat thinly & uniformly

*1: Refer to the illustration above.

2. Preventive Maintenance
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3. Replacement and Adjustment

Service Tool
The table below describes the maintenance tools necessary for the maintenance of this equipment.

Part number Name Qty

54429103 Launa oil 1

A2579300 Grease-Barrierta S552R 1

VSSM9000 Digital Multimeter - Fluke 187 1

G4049005 RS-13 Chart (A4) 1

11
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Procedure for Disassembly and Reassembly

• Disconnect the power cable and remove the AC plug from the outlet before disassembly and assembly.

• Perform disassembly and assembly in a clean location.

• Follow the disassembly and assembly procedures carefully. Never loosen the screws of parts other
than those being disassembled.

• Store the disassembled parts in a clean, uncluttered place to avoid loss.

• After replacement, verify that contacts and parts are correctly aligned.

• Assemble the parts in the reverse order of the disassembly procedure.

Document Cover

1. Lift the document cover [A], as shown in the figure above.

3. Replacement and Adjustment
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2. Push the latch of the left hinge (larger of the two) [A] with a small flat screwdriver and lift out the left
hinge.

3. Push the spring of the right hinge (smaller of the two) [B] with a small flat screwdriver and lift out the
right hinge.

Procedure for Disassembly and Reassembly
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4. Remove the document cover, then disconnect the interface cable.

• Before reinstalling the document cover, clean the document cover first.

3. Replacement and Adjustment
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Main Board

1. Turn the machine over to reveal the bottom as illustrated and remove the five fixing screws (s: M3x8)
on the metal cover.

2. Raise the metal cover and remove all cables [A] including the flat cable.

Procedure for Disassembly and Reassembly
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3. Remove fixing screws (s x 7) and the connector of the interface cable.

4. Main board

Operational Panel Board

1. Remove the document cover (* Document Cover).

3. Replacement and Adjustment
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2. Turn the machine over as shown above. Remove the four fixing screws (s: M3x8) of the operation
panel.

Procedure for Disassembly and Reassembly
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3. Loosen the operation panel [A] by pushing it forward as shown above.

• You are loosening the top half of the front section. The operation panel can be removed
separately from the bottom half of the front section of the machine.

3. Replacement and Adjustment
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4. Disconnect all cables [A].

5. Remove the seven fixing screws (s: M3x8) on the operation panel board.

Procedure for Disassembly and Reassembly
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6. Remove the cable [A] on the operation panel board.

7. Operation panel board.

LCD

1. Remove the operation panel (* operation panel board).

3. Replacement and Adjustment
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2. Remove four fixing screws (s: M3x8) on the LCD cover.

• Be careful not to turn the operation panel over at this point, as the various buttons will fall out of
their correct positions in the panel.

3. Remove the LCD panel.

Upper Housing

1. Remove the operation panel (* operation panel board).

Procedure for Disassembly and Reassembly

21

3



2. Remove two upper housing caps (which cover two fixing screws).

3. Remove the two fixing screws (s: M4x10).

4. Remove the three fixing screws (s: M3x6) on the front of the product.

3. Replacement and Adjustment
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5. Gently remove the upper housing [A].

• Before reinstalling the upper housing, clean the glass surface.

• Be sure to use the correct fixing screws when reassembling the upper housing.

Scanning Unit

1. Remove the upper housing (* Upper Housing).

Procedure for Disassembly and Reassembly
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2. Move the scanning unit [A] to the center.

3. Unhook the end of the scanner drive belt [B] from the bottom housing.

3. Replacement and Adjustment
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4. Raise one end of the sliding rod [A] and gently remove it from the scanning unit.

5. Disconnect the flat cable [A]

• Although the sticker indicates "DO NOT DETACH", if you need to remove the cable to replace
the Scanning Unit, you must remove this sticker. You will likely have to break the tape at the
junction, but the tape is only a safeguard against casual removal and isn't necessary.

• Upon reassembly, be sure to have the flat cable correctly oriented, with the text side facing up,
and be sure to push the cable all the way into its socket. Lightly tug at the cable after reconnecting
it to verify that it is firmly connected. If the cable is not firmly connected, it will fall out.

Procedure for Disassembly and Reassembly
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6. Scanning Unit [A].

• When reinstalling the scanning unit, be sure not to touch the chips of the CCD board or the lamp
of the scanning unit.

Lamp Inverter

1. Remove the scanning unit [A] (* scanning unit).

2. Remove the two fixing screws (s: M3x6) of the lamp holder.

3. Replacement and Adjustment
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3. Remove the lamp inverter [A] from the black plastic clip.

4. Disconnect the lamp inverter cable [B].

5. Turn over the scanning unit to disconnect the lamp inverter cable [A].

Procedure for Disassembly and Reassembly
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6. Lamp inverter

Lamp

1. Remove the scanning unit (* scanning unit).

2. Remove the lamp inverter (* lamp inverter).

3. Gently remove the lamp from the lamp holder.

4. Lamp.

Scanner Motor

1. Remove the scanning unit (* scanning unit).

2. Remove the lamp inverter (* lamp inverter).

3. Remove the lamp (* lamp).

3. Replacement and Adjustment
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4. Loosen the two fixing screws (s: M3x8) from the motor brackets [A].

5. Disconnect the motor cable [A] to completely remove the motor.

Procedure for Disassembly and Reassembly
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6. Motor

ADF Feed Roller

1. Open the ADF front case [A].

2. Hold both ends of the roller stopper [B] and move it down as shown above.

3. Replacement and Adjustment
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3. Move the ADF feed roller [A] to the right first to loosen and detach the left end of the ADF feed roller,
then gently detach the right end of the ADF feed roller from the slot to remove the ADF feed roller.

4. ADF feed roller

To install the ADF feed roller

1. Insert the right end of the ADF feed roller into the slot first, then move the left end of the ADF feed roller
up as shown above.

Procedure for Disassembly and Reassembly
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2. Insert the left end of the ADF feed roller [A] in its original position as shown above.

3. Move the roller stopper up and insert it into the slot as shown above.

3. Replacement and Adjustment
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ADF Upper Case

1. Remove the Input paper tray by holding both ends and lifting the Input tray up.

2. Remove the two fixing screws (s: M3x10) on the top of the cover.

3. Remove the document cover (* Document Cover).

Procedure for Disassembly and Reassembly
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4. Turn the document cover over, and remove the two fixing screws (s: M3x8) one on each side.

5. Turn the document cover over.

6. Insert a flat screwdriver into each of the two indicated slots [A] to release the ADF upper case [B].

3. Replacement and Adjustment
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7. Remove the ADF upper case in the arrow direction to lift it.

8. ADF Upper Case

• Remove carefully to avoid breaking the cables [A].

ADF Top Cover

1. Remove the ADF upper case (* ADF Upper Case).

Procedure for Disassembly and Reassembly
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2. Remove the fixing screw (s: M3x8) on the side of the machine, near the motor gears.

3. Remove the fixing screw (s: M3x8) on the other side of the ADF unit.

3. Replacement and Adjustment
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4. Remove the ADF front case [A].

ADF Paper Set / Exit Sensor

1. Remove the ADF front case. (* ADF Front Case Removal)

Procedure for Disassembly and Reassembly
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2. Raise the ADF upper case [A] to reveal its bottom as shown above.

3. Remove the two fixing screws [B] (s: M3x6) on the metal cover of the paper set sensor.

4. Hold both ends of the paper set sensor [A] to remove it from the slot.

3. Replacement and Adjustment
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5. Hold both ends of the paper exit sensor [A] and remove it from the slot.

6. Remove the cable binder and disconnect the sensor cable [B].

7. Paper set / exit Sensor [A].

ADF Main Board

1. Remove the ADF front case (* ADF Front Case).

Procedure for Disassembly and Reassembly

39

3



2. Remove the fixing screw (s: M3x4) at the end of the roller.

3. Remove the fixing screw (s: M3x8) on the ADF main board.

3. Replacement and Adjustment
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4. Remove the fixing screw (s: M3x8) of the ground wire and unplug all cables to remove the ADF main
board [A].

5. ADF Main Board

ADF Motor

1. Remove the ADF front case (* AD Front Case).

Procedure for Disassembly and Reassembly
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2. Make the ADF unit stand with the gears on the top as illustrated above, and remove two fixing screws
(s: M3x6).

3. Replacement and Adjustment
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3. Remove the e-rings on the three gears at the top [A] (e x 3).

Procedure for Disassembly and Reassembly
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4. Remove the three gears at the top and then remove two fixing screws (s: M3x5), after that remove
the ADF motor.

3. Replacement and Adjustment
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5. ADF Motor.

Procedure for Disassembly and Reassembly
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3. Replacement and Adjustment
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4. Troubleshooting

Troubleshooting Flowchart

Turning Machine Power On
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Copy Operation

4. Troubleshooting
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E-mail Operation

Troubleshooting Flowchart
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Filing Operation

4. Troubleshooting
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Fax Operation

Troubleshooting Flowchart
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Tables

LCD Does not Display

Table 1.1

Cause Relevant Unit Check Method Maintenance Method

Unplugged from outlet None Visual check
Insert the AC plug into the
outlet

DC power unplugged from
unit

None Visual check
Insert the DC power adapter
cable into the unit

AC voltage failure None
AC outlet voltage
check

None

Power adapter output
voltage failure

Power adapter
Output voltage
(+24v) check

Replace the power adapter

PCB failure Main control PCB
Tester check
(+24V, GND)

Remove the cause or replace
the PCB

LCD module main board
connection failure

LCD module main
board

Visual check
Plug in the connector and
secure it firmly

Printer Does not Respond

Table 1.2

Cause Relevant Unit Check Method Maintenance Method

Printer cable

failure

Printer cable
Visual check

Secure printer cable firmly or
replace the printer cable

Main PCB Replace the PCB

Printer link failure

Printer paper jam

Visual check

Remove paper

Printer paper
empty

Insert paper

4. Troubleshooting
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Cause Relevant Unit Check Method Maintenance Method

Printer problem See printer manual

Printer busy Wait till printer ready

Scanning is not Performed

Table 1.3

Cause Relevant Unit Check Method Maintenance Method

Scanner flat cable failure
Scanner flat
cable

Visual check Attach the scanner flat cable

Scanner link failure
Main PCB

Visual check
Replace the PCB

Scanning unit Replace the scanning unit

Printer does not Print

Table 1.4

Cause Relevant Unit Check Method Maintenance Method

Wrong printer selected Printer Visual check
Make sure the printer information
on the LCD display is correct.

Incorrect paper size Paper tray Visual check
Replace paper tray or change
settings to match type of paper
loaded.

Printer problem None Visual check Check printer

Tables
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Image Unclear

Table 1.5

Cause Relevant Unit Check Method Maintenance Method

Lamp too dark Lamp Visual check Replace the lamp

Dirt on the glass Glass Visual check
Clean the glass with clean damp
cloth.

Printer toner low Printer toner Visual check
Check printer toner or replace
the toner

Printer memory not

enough
Printer Visual check Add printer memory

Noise Generated

Table 1.6

Cause Relevant Unit Check Method Maintenance Method

ADF motor / Scanner
motor failure

Motor unit Visual Check
Replace the ADF motor or the
Scanner motor or the gears.

Main board None Replace the main board

Scanning unit failure Scanning unit
Check scanning
unit slack (free-
play)

Replace the scanning unit

Dirt on rod / flame None Visual check
Clean the rod or the flame with
oil

4. Troubleshooting
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LCD Does not Show Message after Command

Table 1.7

Cause Relevant unit Check method Maintenance method

LCD cable failure Panel cable Visual check
Attach the LCD cable and secure it
firmly.

LCD problem LCD Replace the LCD Replace the LCD

Push button failure
Operation panel
board

Replace the
operation panel
board

1. Check the panel cable and
secure it firmly.

2. Replace the operation panel
board.

Machine not Connected to Network

Table 1.8

Cause Maintenance Method

RJ-45 connector is not plugged in Plug the connector in.

Network cable is damaged Replace with a good one

IP address is invalid Ask your network administrator for a valid address.

Subnet Mask is invalid Ask your network administrator for a valid value.

Gateway IP is invalid Ask your network administrator for a valid address.

Information Messages

2.1: Scanning and Copying

Message Problem/Solution

Home sensor error Restart the machine.

Tables
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Message Problem/Solution

If the message still appears, Check home position sensor. If the home position
sensor is malfunctioning, replace the scanning unit.

Lamp error

Restart the machine.

If the message still appears, check the following in succession.

1. Check if the lamp cable and the inverter cable have been connected
firmly.

2. Check the lamp, inverter or main board. If the one of them is
malfunctioning, replace it.

ADF paper jam

Open the ADF cover and remove any paper there, then restart the machine.

If the message still appears, check the following in succession.

1. Check if the ADF cable has been connected firmly.

2. Check if the paper set sensor, paper exit sensor main board, and/or the
ADF main board have malfunctioned.

3. Check the paper path.

If any one of these has malfunctioned, replace it.

Lock error

Scanning unit is locked.

1. Turn off the machine.

2. Find the lock switch underneath the machine and unlock the machine.

3. Restart the machine

If the message still appears and simultaneously the scanning unit does not
move, even though the motor is making noise, check the following:

• Scanner motor

• Home position sensor

If any one of those is malfunctioning, replace it.

Check printer cable or
status.

1. Check if the printer cable has been correctly connected.

2. Check if the printer is turned on.

3. Restart the machine and the printer.

4. If the message still appears, check the printer functions.

4. Troubleshooting
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2.2: Networking

Message Problem/Solution

The connection has failed.

Check network settings.

Ping the IP address of the machine from another PC
in DOS prompt. For example, type “Ping
10.1.20.144” in DOS prompt. If the machine does
not respond, then perform the following steps.

1. Check if the RJ-45 connector is firmly plugged-
in.

2. Check the LAN cable.

3. Check the machine’s IP address.

4. Check the destination IP address.

5. Check Subnet Mask.

Check Gateway IP.

The address is invalid.

Check network settings.

Network is down.

Check network settings.

Network is unreachable.

Check network settings.

Connection aborted by the server.

Check network settings.

Connection reset by the server.

Check network settings.

Connection timed out.

Check network settings.

Unable to reach the destination host.

Check network settings..

Failed to connect mail server.

Check network environment.
Check network environment.

Connection error.

Check network environment.

Failed to create socket for DHCP

Check IP address of DHCP server or contact your
network administrator for further help.

Failed to search DHCP server.

Failed to get IP from DHCP server.

Failed to renew IP from DHCP server.

Tables
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2.3: E-Mailing

Message Problem/Solution

Sequence error
Reboot the machine, and try later. If the error is
still there, replace the main board.

Internal device failure
Reboot the machine, and try again. If the error is
still there, replace the main board.

Failed to connect mail server
Contact your network administrator for further
help.

Failed to get response from mail server.
Contact your network administrator for further
help.

SMTP server is empty.

Please specify SMTP server in User Tools.

Please specify IP address of the SMTP server by
pressing the User Tools button on the panel.

SMTP server address is wrong.

Please check SMTP server.
Check the IP address of the SMTP server.

Unpredicted error
Contact your network administrator for further
help

Insufficient System Storage
Contact your network administrator for further
help.

Mail server doesn’t support SMTP service extension
Contact your network administrator for further
help.

Mail server doesn’t support SMTP log-in
authentication.

Contact your network administrator to turn on
SMTP log-in option.

SMTP log-in error Check your log-in user name.

Mailbox Unavailable Check “To” address.

Processing Error
Contact your network administrator for further
help.

Temporary authentication failure

Contact your network administrator for further
help on mail server’s authentication mechanism.

Choose SMTP authentication for E-mail security or
turn off the mail server’s authentication and try
again.

4. Troubleshooting
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Message Problem/Solution

Command error
Reboot the machine, and try again. If the error is
still there, replace the main board.

Parameters or argument error

1. Check if the Device Name is valid. The
Device Name can be found in User
Tools>General.

2. Check “From” address.

3. Check “To” address.

4. Contact your network administrator for
further help.

Command parameters not implemented

Check if the Device Name is valid. The Device
Name can be found in User Tools>General.

Or you may contact your network administrator
for further help.

Authentication required

Contact your network administrator on mail
server’s authentication mechanism.

Choose SMTP authentication for E-mail security or
turn off the mail server’s authentication and try
again.

Mailbox unavailable Check “To” address.

User not local Check “To” address.

Service unavailable
Contact your network administrator for further
help.

Mail server does not support SMTP service
extension.

Contact your network administrator for further
help.

Exceeded storage allocation

1. Check “To” address.

2. Check mailbox storage allocation.

3. Contact your network administrator for
further help.

Mailbox name is not allowed Check “To” address.

Mail action has not been taken. Check “To” address.

Connection error 1. Check network environment.

Tables
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Message Problem/Solution

2. Check if email attachment size is larger than
the mailbox quota.

The transaction has failed.
Contact your network administrator for further
help.

2.4: Filing

Meaning Problem/Solution

Can not create a subfolder. Make sure you have sufficient privileges.

Internal device failure
Reboot the machine, and try later. If the error is still there, replace
the main board.

Failed to connect FTP server.
Make sure the FTP server is not shutting down and that the port
number is correct. If the error is still there, contact your FTP server
administrator.

Unexpected error Contact your network administrator for further help.

FTP log-in name error Check your log-in name and try again

FTP password incorrect Check your password and try again

FTP can’t enter this directory. Make sure your have privileges to enter this directory.

FTP can’t verify file existence Make sure your have privileges to browse this directory.

FTP can’t change data transfer
type.

Contact your server administrator for further help.

FTP file store error Make sure your have privileges to store files on the server.

Insufficient storage space in
system.

Check FTP server free storage space and contact your server
administrator.

File name not allowed. Change file name to meet naming convention of FTP server’s OS.

FTP permission denied. Check the privileges of your account.

CIFS (User level) can not make
subdirectory

This account doesn't have write privileges to create new
subdirectories.

4. Troubleshooting

60

4



Meaning Problem/Solution

CIFS Network share name
incorrect.

Check directory in folder and make sure it follows UNC, such as \
\Computer\Share\directory.

Failed to connect CIFS Check if server supports CIFS (SMB) connection.

CIFS Computer name error Make sure computer name in the directory is correct.

CIFS dialect negotiation failed. This CIFS may not support PC NETWORK PROGRAM 1.0 dialect.

CIFS (User level) log-in fail. Check log-in name and password, and then try again.

CIFS has failed to create file. Make sure you have full control privileges for relevant shared folder.

CIFS send data error Check your network administrator for help.

CIFS failed to send file attribute. Make sure you have full control privileges.

HTTP unauthorized
This HTTP server needs authorization. Make sure your account has
correct authorization.

Failed to connect to HTTP
Check Server IP and HTTP ports. Make sure they are correct, or
Check whether that server supports HTTP connections.

HTTP Resource not found
If you can't save files on that server, contact your server administrator
for help.

HTTP Forbidden
This action is forbidden on this server. This is not unauthorized, but
is forbidden.

Unexpected error
Reinstall the latest software, or replace the main board, or contact
your server administrator for help

HTTP MKCOL method not
allowed

Contact server administrator to change permissions for this privilege.

HTTP MKCOL method not
implemented

HTTP server does not support MKCOL to create directory. Give up
creating a new directory or create directory at server in advance.

HTTP PUT method not allowed Contact server administrator to change permission for this privilege.

HTTP internal server error Contact your server administrator for further help.

HTTP PUT method not
implemented

That server does not implement HTTP PUT method. This product can’t
store files on this server, contact your system administrator for help.

HTTP server unavailable Contact your server administrator for help.

Tables
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Meaning Problem/Solution

HTTP server does not support
HTTP version 1.1

That server does not support HTTP version 1.1 (which the product
does use), contact your server administrator for help.

POP3 server address is wrong. Check IP address of POP3.

Failed to connect to POP3 server. Contact your network administrator for help.

Failed to log-in to POP3 server. Check log-in name and password.

LDAP server log-in error Check log-in name and password.

LDAP server IP error
Check IP address of LDAP server. Or contact your network
administrator for help.

LDAP port error Check if the port number is correct.

LDAP user password error Check if the password is correct.

2.5: Faxing

• When a problem occurs during faxing, only “Communication Error” will be indicated on the LCD-
display. The information codes which indicate possible causes will only be shown in the Fax Activity
Report. To print the Fax Activity Report, simply select “Yes” or “Error only” in the “Transmission
Report” option after pressing the “User Tools” button and choosing Fax Settings and then Options.

Error

Code
Problem/solutions

0 Fax is finished & OK.

0200

An error has occurred, but the cause is unknown as no message was received from the
sending (remote) fax machine.

• Check the remote fax machine and then try again.

0201
No Dial Tone

"Detect Dial Tone" is enabled and there is no dial tone detected.

0202

Can not get proper modulation for V.34.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

4. Troubleshooting
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Error

Code
Problem/solutions

0203

No fax response.

CED is not detected. The remote modem or fax modem has not sent a fax message within
the specified time.

• Check the remote fax machine and then try again.

0204
Destination line is busy.

• Wait a few seconds, then try again.

0205 User has cancelled the job during scanning or transmission.

0207

In phse D, when doing a Tx job & receiving CRP

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

0209

Disconnect signal is received during sending or receiving.

The remote fax machine may be disconnected.

• Check the remote fax machine and then try again.

0212

In phase D, when receiving CRP with a count of >= 4 or in phase B, when receiving CRP
with a count of >=2.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

0213

In phase AB, DIS's content shows Rx & Polling is disabled.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

• Please try again or use another line.

0215

In phase AB, DIS's content shows Polling is disabled.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

• Please try again or use another line.

0225

In phase B, the training speed is the lowest speed & still receives FTT.

The line quality is poor.

• Please try again or use another line.
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Error

Code
Problem/solutions

0226

In phase D, when doing a fax job and receiving PIN & ERR.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

0229

In phase C, when doing a Tx ECM job and it can not send an ECM block successfully.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

0230

When doing Tx Non-ECM job, system can not receive the file attempting to be sent.
When doing Tx ECM job, system can not get receive the file attempting to be sent.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

0234

1. When doing an Rx job, the system will check whether there is enough free space.

2. Can not create Rx job successfully.

3. Can not create Rx file successfully for writing.

4. In phase D & Non-ECM mode, when receiving EOP; PRI_EOP; MPS; PRI_MPS; EOM;
or PRI_EOM, the system unsuccessfully attempts to save Rx file.

5. In phase D & ECM mode, when receiving PPS_EOM; PPS_PRI_EOM; PPS_EOP;
PPS_PRI_EOP; PPS_MPS; PPS_PRI_MPS or PPS_NULL, the system unsuccessfully
attempts to save Rx file.

Memory Full:

• Check if the printer is connected. If the printer is not connected, the scanned image
will be stored in MFP’s memory.

• Your printer may produce an error message. Check and solve the problems.

• Check Send Later jobs. These jobs are waiting (in memory) to be transmitted. Carry
out these transmissions to free up some memory.

• Current memory is not enough to process the scanning job.

Press “Start” to send the pages successfully scanned or “Stop” to abort the job.

You may choose a lower resolution or try to send fewer pages at once.

0237 In phase D, when receiving RTN and the country code is "Germany".

4. Troubleshooting
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Error

Code
Problem/solutions

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.

0238

In phase D, when receiving ERR.

1. Your fax machine receives a damaged fax transmission from a remote fax machine.

2. The line quality is poor.

• Please try again or use another line.
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Other Troubles

Clearing a Paper Jam

In the event of a paper jam, follow the procedures below to remove the paper:

1. Gently open the ADF front cover [A] to the left.

2. Carefully pull the paper out of the ADF unit.

3. Close the ADF front cover. The product should now be ready to use.

Removing Abnormal Line Images

• When a scanned image is made by ADF, refer to the details below.

When the scanned image has abnormal lines in it, clean the white area [A] on the glass as indicated below
with a clean lint-less cloth.

4. Troubleshooting
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Reasons why abnormal lines can occur:

1. When the machine receives a scan command, for example, after a user presses the B&W Start or
Color Start button, the scanning unit [C] (underneath the white area) which is beneath the document
glass begins to move a few steps forward and stops at the white area [A].

2. Then, the paper from the ADF passes through the pickup mylar [B] to allow the scanning unit
(underneath the White Area) to capture the image, with motion provided by the paper moving past
the scanner.

Therefore, if there is a large enough particle of dust or particle on the white area [A], the scanning unit will
capture the dust and scan as a dot. When the paper goes through the pickup mylar from the top of the
page till the end of the page, the dot image will be reproduced continuously and then finally become a
line.

To avoid poor quality scanned images, be sure to clean the white area [A] occasionally.

Other Troubles
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5. Service Table

Accessing Fax Service Mode
To access the service mode for the fax function:

1. Reboot the machine and press “2” on the numeric keypad.

2. The screen will indicate the service mode is available.

3. Press the User Tools button on the operation panel and then choose Fax Settings.

4. Choose the Option tab and then the Service Mode button to display the Service Mode screen. The
options are described below in detail.

Service Mode

Settings

Item Description

Activity Report

Choose 'Enable' to print a report showing a record of every 50
communications between the sending and receiving fax
machines. The report may contain information and results which
is useful to troubleshoot a particular problem. (The default setting
is Enable.)

Tone/Pulse
Sets the fax modem to dial out using Tone or Pulse. The default
setting is Tone.

Fax Header

Choose Enable to display a fax header, including ID#, date and
time, the receiving fax number, and page index to be shown at
top of all outgoing faxes. (The default setting is Enable.) For
many countries, the fax header is required for a legal fax
document.

Attenuator
This setting has a range between 0 to 15 dB. It should be left at
its default value of 0 dB.

MF Attenuator
This has settings with a range between 0 to 15 dB. It should be
left to its default value of 0 dB.

Transmission Rate Sets the modem’s transmission rate.
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• Settings: 33.6Kbps, 28.8Kbps, 14.4Kbps, 9.6Kbps,
4.8Kbps. The default setting is 33.6Kbps.

If the fax is indicating communications errors, use this setting to
select slower rates to determine if the communications error is
caused by the phone line.

Monitor Control

Sets to turn on or off the modem speaker.

Choice: Disable, Type 1, Type 2. The default setting is Disable.

Disable silences the speaker.

Type 1 turns on the speaker for 10 seconds during dialing and
the initial connection, and then goes silent.

Type 2 leaves the speaker active for all fax communications.

Pulse Dial Rate
Sets the pulse dialing rate.

Choice: 10pps or 20pps. The default setting is 10pps.

Pulse Make Ratio Choices: 33%, 40%. The default setting is 33%.

Tone Duration
Choices: 75, 85, or 100 microseconds. The default setting is
75 microseconds.

Calling Timer
The waiting time the MFP sends its signal to a remote fax
machine. It should be left to its default value of 60 seconds. Or
you may enter an alternative value via the soft keyboard.

Test Mode
Click to perform an initial test to check if the transcending signals
are correct.

Item Options

Tone Send Test
Choices: 2100Hz, 1850 Hz, 1650 Hz, & 1100 Hz. The default
setting is 2100Hz.

DP Send Test
Choices: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9,*, & #. The default setting
is 0.

MF Send Test
Choices: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9,*, & #. The default setting
is 0.

Modem Signal Send Test
Choices: V.34 (33.6 kbps), V.34 (28.8 kbps), V.17 (14.4
kbps), V.17 (12.0 kbps), V.17 (9.6 kbps), V.17 (7.2 kbps), V.
29 (9.6 kbps), V.29 (7.2 kbps), V.27 (4.8 kbps), V.27 (4.8

5. Service Table
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kbps), V.27(2.4 kbps), V.21 (0.3 kbps). The default setting is V.
34 (33.6 kbps).

Off-Hook Test Click to perform Off-Hook Test.

Accessing Fax Service Mode
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Updating System Firmware
To update system firmware, please follow these steps:

1. Download the latest firmware from the web site. (file extension .spf)

2. Install the Network Management Tool by placing the Scanner Driver CD-ROM into your CD-ROM
drive. In a second, the installation graphic appears.

3. Choose Network Management Tool and follow the on-screen instruction to complete the installation.

4. Start Network Management Tool by choosing Start>All Programs>IS800C Network Management
Tool>IS800C Network Management Tool.

5. In a second, the Network Management Tool main screen appears as above.

6. Choose New Device from the File menu to prompt the following New Device dialog box. Or you may
click the new device tool from the toolbar. Or double click the large new device icon.

5. Service Table
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7. Enter the IP address of your machine as illustrated.

8. In a second, the IS800Cs on the network will be displayed in the main screen as follows.

9. Choose a device which you wish to update its firmware.

10. Choose Update Firmware from the Tools Menu and then choose the latest firmware file. (.spf file)

11. In a second, The Update OK message will be prompted.

12. Reboot your machine to complete the update.

Updating System Firmware
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6. Detailed Section Descriptions

External View

The Front View

1. Input Paper Tray and Paper Support

2. Document Cover

3. Document Stopper

4. Handle

5. Operation Panel

6. LCD-display

7. ADF Unit

The Connection Ports
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1. Line Jack
To connect the product to a “RJ-11” telephone jack (provided by the
telephone company with a telephone line).

1. Phone Jack
This Phone jack is currently empty, since no handset is provided with the
product.

1. LAN Port To connect to a network via a LAN cable.

1. USB Printer Port To connect a printer via a USB cable.

1. USB Port To connect a computer as a USB scanner.

1. ADF Port To connect the ADF unit with an ADF cable.

1. 24VDC/2.0A To connect the power cable.

1. Power Switch To turn the machine on and off.

6. Detailed Section Descriptions
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Overview

Theory of Operation

The reflected rays of your original (as shown in the diagram above), pass through the lens and create an
image on the CCD (Charged Coupled Device). Then, according to the different light intensity perceived
by the CCD, the CCD will transfer this data as an analog signal to the main board, where the signal is then
turned into a digital signal.

The digital signal flows to the image processor and on to the CPU (Central Processing Unit). Through the
commands from the Operation Panel, the digital signal can go to the 1284 Controller and to a printer for
printing or to RJ-45 for SMTP or a file server to send an email or store an image. Or, the digital signal may
go to RJ-11 for the modem to send a fax to a G3 fax machine.

External View
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Main Control Unit

System Block Diagram

• LVDS (Low Voltage Differential Signaling):

This IC sends digital data to the LCD Controller.

• CPU SDRAM:

This is the main memory for data. (32MB x 2)

• Flash ROM:

This contains the scanner firmware. (8.5MB)

6. Detailed Section Descriptions
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Drive Mechanism

ADF Drive

The ADF motor [B] rotates the ADF roller [A], and feeding roller [C].

Main Control Unit

79

6



Scanner Drive

Scanner motor [A] moves the scan unit through a pulley and a belt [B].

Scanning Overview

6. Detailed Section Descriptions
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Initializing

• The lamp [A] illuminates the document. The image is reflected onto a CCD [B] (Charge Coupled
Device) via several mirrors, and through the lenses.

• When you turn on the machine, the scanning unit [C] moves a step forward and then backward to
perform an initial test (including to verify that the scanning unit is unlocked). (If the lock switch has not
been set to Unlock, the machine will make a noise.) If the lock switch has been set to "Unlock", the
lamp will turn off and on again. After this, the scanning unit moves a few inches forward to perform
calibration.

• After the calibration operation is finished, the scanning unit moves to the home position [D].

Scanning Procedure

Platen mode:

1. When the machine receives a scan command, the scanning unit performs a calibration and then scans
the document.

2. After scanning the document, the scanning unit moves to the home position.

3. The scanning unit then stops at the home position.

ADF mode:

Main Control Unit
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1. The scanning unit calibrates itself (moving to the scanning position).

2. The paper from the ADF goes through the pick-up mylar [E].

3. The scanning unit scans the document.

4. After finishing scanning the document, the scanning unit returns to the home position.

5. The scanning unit stops at the home position.

Video Circuit

CCD Signal Processing Circuit

The CCD signal processor includes all the necessary circuitry to perform three-channel conditioning and
sampling. The signal chain consists of three-channel correlated double sampling (CDS) and programmable
gain adjustment of the CCD output (PGA) is a 16 bit analog to digital converter (ADC) quantizes the analog
signal.

* PGA: Programmable Gain Amplifier

6. Detailed Section Descriptions
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7. Specifications

Specifications
General Specifications

Type A4 Flatbed with ADF

Memory Size
System: 64 Mbytes,

Image: 64 Mbytes

Flash Memory Size 8.5 Mbytes

Light Source Cold Cathode Fluorescent Lamp

Color Output Quality
24 bits Color, 8 bits Gray

4 bits CMYK, 1 bit mono

Optical Resolution 600 х 600 dpi

Network Connection 10/100 Mbits auto-negotiation

Dimensions (W x D x H) 444 x 412 x 272 mm (with ADF)

Weight 6.2 Kg (With ADF)

Warm Up Time 45 seconds

Power Supply 24 Vdc, 2 A

Power Consumption

Working < 36 W

Standby < 24 W

Sleep < 18 W

USB Printer Port USB 2.0

USB Device 2.0 Port VisionMax 800 embedded

LAN Controller

RTL8100CL

10/100 Mb

Full compliance with IEEE802.3u 100Base-T

Full duplex, IEEE802.3x

RJ45 connecter
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LED : Link, TX/RX

Power Saving Mode Time to 0ff: 5/15/30/60/240 minutes

Acoustic Noise

Standby 45 dB

Flatbed Scanning 54 dB

ADF Scanning 58 dB

Flatbed Specifications

Maximum Scanning Area (Flatbed) 8.5” x 11.69”

Warm Up Time 45 seconds

Recovery Time

(from sleep mode)
45 seconds

Maximum Document Thickness 13 mm (Cover open when over 13 mm)

Auto Document Feeder Specifications

Capacity 50 sheets (Xerox 4024 DP 20 lb paper)

Dimensions (W x D x H) 434 x 292 x 177 mm

Weight 1.6 Kg

Document Size
Width:4.5”∼ 8.5”

Length: 5.5” ∼ 14”

Paper Feed Face Up

Paper Weight
16 lb ∼ 28 lb (60 g/m2 ∼ 105 g/m2)

(0.002”∼0.006”)

Copy Specifications

Copy Port USB 2.0 Host Rev 2.0

Printer Language PCL5

Multi-Copy Speed (ADF)

B&W: 18 cpm (copies per minute)

Speed mode: 11 cpm

Speed mode: 11 cpm

Multiple Copies (Copy count) Up to 99

7. Specifications
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Copy Print Resolution 600 x 600 dpi

Original Size Up to Legal (ADF)

Copy Size Up to Legal

Density Control 1 ∼ 7 levels

Zoom 25% ∼ 400%, in 1% increments

Paper Supply Legal, Letter, A4, B5, A5

Scaling

100%

70% (A4 → A5)

78% (Legal → Letter)

86% (A4 → B5)

115% (B5 → A4)

127% (Letter → Legal)

141% (A5 → A4)

93% (whole page)

Network Specification

Configuration Requirement

IP address

Subnet mask

Gateway

SMTP server/POP3 server

FTP server

Web server

E-mail Specifications

Protocol SMTP, MIME,

Mail Sever Authentication SMTP-AUTH, POP3

File format

B/W (single bit): PDF, TIFF, M-TIFF

Gray (8 bit): PDF, JPEG, TIFF, M-TIFF

Color (24 bit): PDF, JPEG, TIFF, M-TIFF

Compression Method
B/W: RAW, G3, G4

Gray: JPEG

Specifications

85

7



Color: JPEG

Compression Level Low / Medium / High

Supported Resolution 75, 100, 150, 200, 300, 400, 600 dpi

Default Resolution 200 dpi

Address Book Capacity

Maximum Addresses: 2000

Groups: 100

No. of Addresses in Each Group: 99

Supported Mail Server

Lotus Mail Server 5.0

MS Exchange Server 2000/2003

RedHat 7.0 SendMail

Supported LDAP Server

Windows 2003 Active Directory with SFU ( Service for Unix)

Windows Server 2000 + MS Exchange 5.5

Lotus Notes R5

Supported Mail Application

Microsoft Outlook 2000

Microsoft Outlook Express 5.0

Microsoft Outlook Express 6

Eudora 4.3.2J

Lotus Notes R5

Fax Specifications

Compatibility ITU-T G3 (ECM)

Modem Speed 33.6 K

Resolution

Receive (dpi):

200 x 100, 200 x 200, 200 x 400 dpi

Send (dpi):

200 x 100, 200 x 200

Compression MH, MR, MMR

Transmission Speed Approximately 3 seconds(*1)

Page Memory 2.5 MB in Flash

Speed Dial 200 sets

7. Specifications
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Compression MH, MR, MMR

*1 : Time of phase C that doesn't contain fax negotiation (ITU No.1chart, Compression: MMR,
Resolution: Standard, Speed: 33.6 kbps).

Filing Specifications

Protocol FTP, HTTP, HTTPS, CIFS

File format

B/W (single bit): PDF, TIFF, M-TIFF

Gray (8 bit): PDF, JPEG, TIFF, M-TIFF

Color (24 bit): PDF, JPEG, TIFF, M-TIFF

Compression Method

B/W: Raw, G3, G4

Gray: JPEG

Color: JPEG

Compression Level Low / Medium / High

Supported Resolution 75, 100, 150, 200, 300, 400, 600 dpi

Default Resolution

B/W: 200 dpi

Gray: 200 dpi

Color: 200 dpi

Most Used Folders 5

Number of Filing Folders 40

PC-Scan Specifications

Operation system
Windows 98SE, Windows 2000, Windows XP,

Windows Vista

Interface USB 2.0

Media Source Flatbed, ADF/Multi-Page

Color Mode

24-bit Color

8-bit Gray

Halftone : Halftone1 ∼ 4, Diffusion

Black & White

Resolution Selection
50/72/100/144/150/200/300/600/1200 dpi

50 ∼ 1200 dpi

50/72/100/144/150/200/300/600/1200 dpi

50 ∼ 1200 dpi

Specifications
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Random

Paper Size Selection

For Flatbed:

Card : 4 x 2.5 (inch)

Photo : 5 x 3.5 (inch)

Photo : 3.5 x 5 (inch)

Photo : 6 x 4 (inch)

Photo : 4 x 6 (inch)

B5

A5

A4

Letter

Scanner Maximum

For ADF:

B5

A5

A4

Letter

Legal

7. Specifications
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